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Upgrading MapInfo Professional

Upgrading
If the MapInfo Professional installer detects a current version of the product, or detects that the product
had been previously installed, then the installer copies the MAPINFOW.WOR, STARTUP.WOR, and
MAPINFOW.PRF files from the operating system's system directory to
C:\Users\<username<\AppData\Roaming\MapInfo\MapInfo.

Application data (appdata) files are the non-executable data files that MapInfo Professional uses during
operation.

How to Uninstall the MapInfo Professional 12.5 Beta Release
This section is for users who participated in the 12.5 Beta Release program and have a Beta release of
MapInfo Professional installed on their machine. You will need to uninstall the Beta release before you
can install this 12.5 release of MapInfo Professional.

You will need to:

1. Uninstall the MapInfo Professional Beta using Programs and Features in the Control Panel and
2. Manually remove MapInfo Professional Beta files that are left behind.

To manually remove the MapInfo Professional Beta files left behind after uninstalling:
1. Locate the MapInfo Professional Beta files by searching for a folder called 1250 on your computer's

C drive.
For example on Windows 7, C:\Users\user
name\AppData\Roaming\MapInfo\MapInfo\Professional\1250

2. Delete the 1250 folder and all of its contents.

You are now ready to install MapInfo Professional 12.5 to your computer.

Windows 8 and Windows 2012 users: If you have a previous version of MapInfo Professional 12.5
installed (a Beta version), then you must reboot your machine after uninstalling the previous version and
installing the latest release. Rebooting correctly registers fonts on your machine, so that MapInfo
Professional can locate and apply style types. If you do not reboot, the fonts are not registered and
MapInfo Professional closes unexpectedly when using the fonts.

Beta testers experiencing an issue using the Help System after installing MapInfo Professional 12.5,
should delete the mapinfo_professional12_5 cache folder under the AppData folder (for example,
C:\users\%USERNAME%\AppData\Local\mapinfo_professional12_5).

Microsoft Warning for 64-Bit Version of Microsoft Office
If you do not have Microsoft Office installed on your machine, then MapInfo Professional 12.5 installs a
Microsoft Office 2010 32-bit driver, so that MapInfo Professional can open Microsoft Access and Excel
2010 files.

If you already have the 64-bit 2010 Microsoft Office driver installed, and you do not have the 2007 32-bit
driver installed, then MapInfo Professional installs the Microsoft Office 2007 32-bit driver. You can still
work with Microsoft Access 2010 and Excel 2010, but you may see an error message if an incompatibility
occurs.

Microsoft strongly recommends using the 32-bit (x86) versions of Office 2010, Project 2010,
Visio 2010, and SharePoint Designer 2010 applications as the default option for all platforms
(including on a 64-bit operating system).

Note:
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License Server Utility
If you have a previous version of the License Server Utility (LSU) installed to manage distributable
licenses, then you must upgrade to the latest License Server Utility, version 4.5. Using a previous version
of the License Server Utility with MapInfo Professional 12.5 will cause MapInfo Professional to become
unresponsive.

Using an incompatible version of the License Server Utility might result in the following issues while
fetching licenses for MapInfo Professional:

• MapInfo Professional is unable to borrow a borrowable license.
• MapInfo Professional is unable to activate a distributed license from the License Server.

If this occurs, contact your License Server administrator and have them upgrade the License Server to
version 4.5.

After successfully borrowing or activating a license, if you again roll back to an older version of License
Server Utility, you con not transfer the borrowed/activated license back to License Server Utility. You
will not see an error message as the operation simply hangs.

Repairing MapInfo Professional from the .MSI file
The repair process fails using the .msi file when the Microsoft User Account Control (UAC) is turned on.
Depending on the installation conditions the repair stops with the following error message:

You have MapInfo Professional running, please close it and run
setup again.

To work around this issue, do one of the following three things:
Shut off the UAC (User Account Control), this requires System Administrative privileges, reboot
the machine, and rerun the repair.

•

• Run the original setup.exe file and then run the repair from maintenance mode.
• Run the installed copy of the MapInfo Professional 12.5 .msi file as an administrator. Go to
C:\Windows\Installer and search for the MapInfo Professional 12.5 .msi file. It will have a
name similar to 8e95f1.msi, where the name is different for each machine. Go to
C:\Windows\System32 and find the cmd.exe file. Right click this file and select Run as
Administrator (this may require an administrator password). Run the command
C:\Windows\Installer\nameofMiPro12.5.msi and selectRepair frommaintenancemode.

Disabling User Account Control (UAC) on Windows 7 or Server 2008 R2
To disable UAC on Windows 7 or Server 2008 R2:
1. Launch MSCONFIG by from the Run menu.
2. In the System Configuration dialog box, click the Tools tab.
3. Click Change UAC Settings.
4. Click Launch.
5. Move the slider to Never Notify.
6. Click OK to close the dialog box.
7. Reboot the machine to have this change take effect.

Disabling User Account Control (UAC) on Windows 8 or Windows Server 2012
To disable UAC on Windows 8 or Windows Server 2012:
1. OnWindows 8, go to theSearch Charm and type Change User Account Control settings.•

• On Windows 2012, on the Control Panel, select User Accounts, and click on Change User
Account Control Settings.
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2. In the User Account Control Settings console, move the slider to Never Notify.
3. Click OK.

You may see a prompt to confirm your selection or to enter an administrator password.

4. Reboot the machine to have this change take effect.

Support Notices

SQL Server 2012

If connecting to a SQL 2012 server with Windows 7 or higher, use the SQL Server Native Client 2012
(also known as SQL Server Native Client 11.0).

Bing Maps Expiration Date

Bing Maps has a limited license period, which is specific to each version of MapInfo Professional. The
Bing Maps and the Add Bing Roads to Map and the Move Map To features cease working after this date:

• MapInfo Professional 12.5 on January 1st 2016
• MapInfo Professional 12.0 on January 1st 2015
• MapInfo Professional 11.5 on January 1st 2014

Customers with a current maintenance package who would like to continue to use earlier versions of
MapInfo Professional (10.5.3, 11.0.x, 11.5.x, or 12.0.x) are entitled to use Bing services until January
1st 2016. For details, contact your account representative.

Downloading Tools and Applications
Several tools and applications are available for download from the Pitney Bowes Software website at
www.mapinfo.com.

www.mapinfo.com/proviewerMapInfo ProViewer

MapInfo ProViewer lets anyone open, view and manipulate your MapInfo
Professional maps, tables and analyses with easy-to-use functionality including
print, zoom, scroll, select objects, measure distances and view details.

www.mapinfo.com/mapbasicMapBasic

The MapBasic development environment is a complete, BASIC-like programming
language used to create custom applications for use with MapInfo Professional
or special MapInfo runtimes. MapBasic allows you to customize the geographic
functionality of MapInfo Professional, automate repetitive operations and integrate
MapInfo Professional with other applications.

www.mapinfo.com/easyloaderEasyLoader

EasyLoader lets you to upload MapInfo .tab files to a remote database, such as
Oracle, SQL Server, Microsoft Access, and PostgreSQL / PostGIS.

To install these downloads, unzip the download file in to your Temp folder (C:\Temp) and then launch
the setup.exe. An install wizard guides you through the installation process.

To obtain more MapInfo Professional resources and downloads, visit www.mapinfo.com/resources.
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Locating Your Documentation
MapInfo Professional documentation, in the form of PDF files, installs with MapInfo Professional in to
the Documentation subfolder. You must have the Adobe Acrobat reader installed to view PDF files.
To download a free copy of the Adobe Acrobat Reader, go to http://www.adobe.com.

Installation Instructions are Available in the Install Guide on the DVD

For system requirements, installation instructions, and System Administrator notes for performing a
workgroup installation, see the MapInfo Professional Install Guide. You can view this document from
the DiscStarter application, which launches automatically when you insert the MapInfo Professional DVD
in to your machine’s drive. From the DiscStarter application:

• Click Reference and then MapInfo Professional Install Guide, or
• Click Browse DVD. This launches an Explorer window. Under the PDF_DOCS folder, double-click the
MapInfoProfessionalInstallGuide.pdf file.

Instructions for Activating your License are in the Install Guide

Instructions for activating your MapInfo Professional license are in theMapInfo Professional Install Guide.
The same information is also in the MapInfo Professional Licensing and Activation Notes
(ActivatingYourProduct.pdf).

The MapInfo Professional Data Directory Document is on the DVD

MapInfo Professional’s sample data comes with the MapInfo Professional Data Directory document,
which describes the sample data. You can view this document from the DiscStarter application, which
launches automatically when you insert the MapInfo Professional DVD in to your machine’s drive. From
the DiscStarter application:

• Click Reference and then MapInfo Professional Data Directory, or
• Click Browse DVD. This launches an Explorer window. Under the PDF_DOCS folder, double-click the
MIProDataDirectory.pdf file.

All Documents Install with your Software

After installing MapInfo Professional, you can find documentation files under the Documentation folder
where MapInfo Professional is installed (for example, C:\Program Files
(x86)\MapInfo\Professional\Documentation).

Documentation is also available on our website at www.mapinfo.com/miprodocs.

Notes about this Release

New Features
For details about new and enhanced features in this release, see theWhat’s New chapter in theMapInfo
Professional User Guide or MapInfo Professional Help System.

This release has new and updated features in MapInfo Professional:

• A new Layout Designer window shows the map using the printer resolution, so that you know what
your printout will look like (it shows the labels that will be on the printed map). This window contains
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a live map that you can edit, has advanced alignment tools, and lets you insert image files directly to
the canvas. For details, seeWorking with Layouts in the Help System.

• A new concurrency setting improves processing speed when buffering an object in a table or selection,
and with overlay operations, such as Split, Erase, Erase Outside, Polyline Split, and Overlay Nodes.
You can select howmuch of the operation to perform in parallel using more than one CPU or processor
core.

• You can now use your own Microsoft Bing Maps license instead of using the license supplied with
MapInfo Professional, which has an expiration date.

• Searches in a Table List window are now more discrete, using all of the terms that you enter in the
search box instead of the entire phrase. A search will find any table alias that matches any of the terms
(separated by spaces) that you enter.

• Users working in a Citrix XenApp environment can now switch to 1-bit per pixel cursors to improve
the speed of rendering their cursors.

• This release includes coordinate system additions or enhancements, new EPS and PRJ codes, and
datums.

• This release updates the MapCAD tool to a new version. This product provides tools that work with
MapInfo Professional to create maps that are appropriate for land development and surveying tasks.

• A new viewer for the Help System gives you advanced search options, lets you bookmark pages,
makes it easier to enlarge text for readability, and lets you dock or float sidebar windows to control
the space in the viewer.

Data Access Updates

• Open and save your data to Microsoft Office 2013 Excel and Access files, and embed maps into Office
2013 Word documents.

• Work with data in Oracle Spatial 11g R2 and 12c R1.
• The Feature Manipulation Engine (FME) has been upgraded to 2014.

New Licensing Options

• Overdraft licenses are now available if you purchased distributable licenses. Overdraft licenses ensure
that you do not have a service disruption if you lose a license during server migrations or failure. You
can overdraft up to 10% of the number of distributable licenses that you own, so if you own 50
distributable licenses you would have up to 5 overdraft licenses available.

• You can now repair up to 10% of the distributable licenses that you own. If you have 20 distributable
licenses as an example, then the License Server Utility will repair up to 2 broken licenses.

For details about these licensing improvements, see the License Server User Guide that installs with
the License Server software.

Service URL for Swedish National Catalog
The service URL for the Swedish National Catalog has changed and the same is updated in this release.

The updated URL is: http://www.geodata.se/InspireCswProxy/csw

Using the New Help System
MapInfo Professional, MapBasic, and ProViewer software come with a new Help System viewer. For
details about using the new viewer, see the notes that come with it by double-clicking the assistant.exe
file located under the QT folder where MapInfo Professional is installed (for example, under C:\Program
Files (x86)\MapInfo\Professional\QT).

To view the Help System outside of the software:
1. Launch the Command Prompt.

From the Start menu type Command Prompt in the search box, or on Windows 8 swipe to the Apps
screen and look under Windows System.

2. Change directories to the QT folder. As an example:

cd C:\Program Files (x86)\MapInfo\Professional\QT
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3. Type the following, but replace the path with your installation location:

assistant.exe –collectionFile C:\Program Files
(x86)\MapInfo\Professional\MapInfoProfessional.qhc

Ensure that you type .qhc as the file extension for the collectionFile input. Depending on the
product help that you want to view, you would type the path to MapInfoProfessional.qhc,
MapBasic.qhc, or MIProViewer.qhc.

To view the help on another machine, copy the QT folder, and the .qhc and .qch files, from the software
installation folder to the machine you want to view the help on. Both .qhc and .qch files must be in the
same folder for the viewer to open the Help System.

Consider creating a batch (.bat) file that you can double-click to invoke the Help System. The
file will contain a single command: C:\Program Files

Tip:

(x86)\MapInfo\Professional\QT\assistant.exe –collectionFile C:\Program
Files (x86)\MapInfo\Professional\MapInfoProfessional.qhc

Known Issues

Editing Text in the Layout Designer Window

There is a Microsoft issue that affects editing text in the Layout Designer window. The mouse cursor
may disappear in a text frame when the Layout Designer zoom value is not set to 100%. Resetting the
zoom value to 100% should correct this issue, which only happens intermittently.

License Server Utility Incorrect Dates

When the RESERVE option is used in the options file (unisw20.opt located in the License Server Utility
installation directory), the licenses are checked out from the License Server Utility with incorrect start
dates.

Printing to PDF

When printing to PDF, the printing progress window may appear frozen and clicking Cancel can cause
MapInfo Professional to halt.

Selecting certain non-default PDF preferences causes this issue. If you experience this issue, change
the PDF preferences back to their default settings:

1. On the File menu, point to Print to PDF to open the Print dialog box.
2. Click Properties to open the MapInfo PDF Printer Properties dialog box.
3. On the Destination tab, uncheck the Prompt for Destination check box.

Running PolyBuilder in MapInfo Professional 12.0 and 12.5

When MapInfo Professional 12.0 and 12.5 are on the same machine, MapInfo Professional 12.0 closes
unexpectedly when running the PolyBuilder tool. The issue persists after you uninstall MapInfo Professional
12.5.

To run PolyBuilder in version 12.0 after installing version 12.5:

1. Launch the command prompt with administrator privileges.
2. Navigate to the directory where MapInfo Professional 12.0 is installed, for example:

cd C:\Program Files (x86)\MapInfo\Professional

3. Run MapInfo Professional 12.0 with the following option:

Mapinfow.exe -regserver
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Correction: We Support Windows 2012 Server 64-bit with XenApp 7.0

This note is for Citrix users. The EasyLoader, License Server, MapBasic, ProViewer, and Runtime
documentation and theMapInfo Professional Install Guide list Windows 2012 Server 64-bit with XenApp
6.5 as a supported operating system environment. This should read Windows 2012 Server 64-bit with
XenApp 7.0. We have not tested with XenApp 6.5.

Correction to the MapInfo Professional User Guide and Help

In the MapInfo Professional User Guide and Help System, the following section under the titleWorking
with Oracle Spatial Tables contains out-of-date information and should read:

Oracle Spatial Requirements

To connect to Oracle Spatial within MapInfo Professional, you must have Oracle Spatial 11g R2 or 12c
R1 installed. For details, see your Oracle documentation and the MapInfo Professional Install Guide.

Progress and Resolution of Outstanding Issues

MapInfo Professional

Description and ResolutionIssue Number

When printing to a PDF, customized labels are still visible after turning off the
labels layer in the resulting PDF file.

MIPRO-16772

When printing to the MapInfo Professional PDF printer, you can choose to put
each layer in the map into its own PDF layer: on the File menu, point to Print to
PDF, click PDF, and then select the Layered PDF check box. Labels are placed
in their own layer, but custom labels (any label that has been explicitly edited in
any way) are not placed in the label layer.

Resolution: Fixed, custom labels are now placed in the label layer.

Labels are incorrectly placed on the map and in the output generated from a
classic Layout window.

MIPRO-29015

Resolution: Fixed.

MapInfo Professional does not recognize the correct number of records in an
Excel file written with FME.

MIPRO-34750

Resolution: Fixed.

Callout labels do not display for small features.MIPRO-36071

Resolution: Fixed.

While translating SHP files using FME, incorrect Coordsys Bounds are assigned.MIPRO-37291

Resolution: Fixed.

The MapInfo Professional 12.0 installer fails to install when the machine has
Visual Studio 2012 with Update 3 or 4 on it, or has Visual Studio Update 3
redistributable on it.

MIPRO-37869

Resolution: Fixed.

MapInfo Professional closes unexpectedly when using the Custom Poly tool for
editing or drawing a polyline.

MIPRO-38975

Resolution: Fixed.
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Description and ResolutionIssue Number

Translating files to TAB format fails with a fatal error when the applied CoordSys
uses Survey Feet units.

MIPRO-39022

Resolution: Fixed.

FME ignores CoordSys Bounds when converting SHP files to TAB format.MIPRO-40394

Resolution: Fixed.

There may be issues on Windows 8.0 when printing text from a window, such as
a Map window, with Enhanced Rendering turned on. The text is processed in

MIPRO-41178

raster form when printing and causes poor quality output as a result. When printing
to PDF or XPS, the text in the output file is not selectable or searchable, and
does not scale well.

Resolution: Microsoft has a hotfix for Windows 8.0 for this issue. If you have not
received the hotfix through a Windows update, then do one of the following:

• Upgrade to Windows 8.1, which includes the hotfix, or
• Download the hotfix directly from

http://support.microsoft.com/kb/2823372/EN-US and install it.

Some text styles, such as halo, shadow, background box, and curved
labels, are rendered as graphical objects, so they do not appear as text
in the output even if you apply a fix.

Note:

MapInfo Professional closes unexpectedly when running SQL Server stored
procedures from a MapBasic application.

MIPRO-41391

Resolution: Fixed.

In the Citrix XenApp environment, there is a delay between cursor movement
and cursor rendering. This is a performance issue when using 32-bit per pixel
cursors.

MIPRO-41421

Resolution: Fixed. You can now switch between 32-bit per pixel cursors and
1-bit per pixel cursors. For details, see the MapInfo Professional Help System.

The Visual FoxPro ODBC driver does not work with MapInfo Professional 12.x
versions.

MIPRO-41696

Resolution: Fixed.

The resolution of Bing images appears lower in MapInfo Professional version
12.0 then in version 11.5.

MIPRO-41869

Resolution: Fixed. This fix improves the appearance of tile server layers, such
as Bing Roads, Bing Aerial, and Bing Hybrid, on the screen and when printing
or exporting.

See MIPRO-41869MIPRO-42409

Resolution: Fixed.

Translating a DXF file using FME changes the projection, so that (NAD 27 for
Canada) changes to (NAD 27 for US).

MIPRO-45442

Resolution: Fixed.

Translating TAB files containing large records to SHP or other external formats
results in an error.

MIPRO-45484

Resolution: Fixed.
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EasyLoader

Description and ResolutionIssue Number

Non-English versions of EasyLoader do not launch.MIPRO-40742

Resolution: Fixed.

License Server

Description and ResolutionIssue Number

The License Server is unable to start automatically when restarting the machine.MIPRO-35627

Resolution: Fixed.

The License Server Utility closes unexpectedly.MIPRO-37464

Resolution: Fixed.
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